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This	repository	has	been	archived	by	the	owner.	It	is	now	read-only.	You	can’t	perform	that	action	at	this	time.	You	signed	in	with	another	tab	or	window.	Reload	to	refresh	your	session.	You	signed	out	in	another	tab	or	window.	Reload	to	refresh	your	session.	Open	the	Settings	or	Preferences	dialog:	On	Windows	or	Linux,	select	File	>	Settings	from
the	main	menu.	On	Mac	OSX,	select	Android	Studio	>	Preferences	from	the	main	menu.	Navigate	to	Build,	Execution,	Deployment	>	Compiler.	In	the	text	field	next	to	Command-line	Options,	enter	your	command-line	options.	Click	OK	to	save	and	exit.	The	top	option	is	Instant	run.	Check/uncheck	that	box.	Documentation	PDF	-	Download	Android	for
free	After	making	a	few	changes	I	am	getting	an	error	Session	'app':	Error	Installing	APKs	According	to	some	it	is	because	of	Instant	Run.	On	the	latest	Stable	Android	Studio	3.0,	under	Build,	Execution,	Deployment	I	don't	have	any	option	for	Instant	Run,	even	checked	in	the	settings	search.	Any	clue	where	I	might	be	able	to	disable	it?	Update	1:
Tried	reinstalling.	No	change.	Build	number	171.4408382	Update	2:	Gave	reset	a	shot	still	nothing.	Update	3:	Not	a	duplicate.	Must	be	something	in	the	settings.	A	complete	clean	install/reset	did	it.	Screenshot	of	what	I	see:	After	making	a	few	changes	I	am	getting	an	error	Session	‘app’:	Error	Installing	APKs	According	to	some	it	is	because	of
Instant	Run.	On	the	latest	Stable	Android	Studio	3.0,	under	Build,	Execution,	Deployment	I	don’t	have	any	option	for	Instant	Run,	even	checked	in	the	settings	search.	Any	clue	where	I	might	be	able	to	disable	it?	Update	1:	Tried	reinstalling.	No	change.	Build	number	171.4408382	Update	2:	Gave	reset	a	shot	still	nothing.	Update	3:	Not	a	duplicate.
Must	be	something	in	the	settings.	A	complete	clean	install/reset	did	it.	Screenshot	of	what	I	see:	Let’s	Solve	it:	This	is	a	common	error	many	developers	questioned	us	about	it.	So	we	write	the	explanation	above.	You	just	have	to	apply	the	suggested	solution	to	your	code	and	it	will	do	for	you.	If	you	still	getting	this	error	after	applying	this	code	then
comment	below	we	will	get	back	to	you	with	the	new	method.	Solution	1	Go	to	Android	Studio	Settings	or	Preferences	(for	MAC)	->	Build,Execution,Deployment	->	Instant	Run.	Then	deselect	the	“Enable	Instant	Run”	checkbox	at	the	top.	Linux	Screenshot:	Windows	Screenshot:	For	Mac	go	to	Help	in	MenuBar	and	type	‘preferences’	or,	go	to	‘Android
Studio	->	Preferences’	in	MenuBar	Mac	ScreenShot	Solution	2	Instant	Run	is	not	a	feature	of	Android	Studio	3.5	(and	later)	any	more	and	so	cannot	be	disabled.	In	case	you	find	an	old	guide	recommending	to	disable	it,	you	can	ignore	this	instruction.	See	here	1	and	here	2.	Solution	3	Just	make	sure	you	go	to	Android	Studio	->	Preferences	instead	of
File	->	Other	settings	->	default	settings.	Instant	run	should	be	there.	Solution	4	Instant	Run	is	removed	from	Android	Studio	3.5	and	added	Apply	Changes	which	works	for	Android	8	and	above	please	follow	the	link	for	more	Solution	5	Finally	fixed!	As	other	users	on	Linux	and	such	saw	the	Instant	Run	option	in	the	settings,	I	tried	reinstalling	and
resetting	the	installation,	following	Removed	all	old	settings,	and	installation	of	Android	Studio(	kept	the	SDK	files).	Changed	the	path.	Opened	the	same	project,	and	the	options	were	now	there!	Solution	6	Easiest/Laziest	option	for	For	mac	would	be	CMD+SHIFT+A	Search	for	instant	run,	click	on	relevant	suggestion	and	uncheck	the	checkbox
Solution	7	Instant	run	is	not	a	feature	in	Android	Studio	Bumblebee	anymore.	Note:	You	are	free	to	use	these	solutions	for	your	personal	use.	We	recommend	you	apply	the	first	solution	to	your	code	because	it	was	tested	in	our	system	before	posting	it	on	this	page.	We	are	always	trying	to	help	the	developer	community,	So	we	made	their	work	easy.
Basically,	we	collected	these	data	from	stackoverflow.com,	As	it	is	licensed	under	cc	by-sa	2.5,	cc	by-sa	3.0	and	cc	by-sa	4.0.	Finally	fixed!	As	other	users	on	Linux	and	such	saw	the	Instant	Run	option	in	the	settings,	I	tried	reinstalling	and	resetting	the	installation,	following	Removed	all	old	settings,	and	installation	of	Android	Studio(	kept	the	SDK
files).	Changed	the	path.	Opened	the	same	project,	and	the	options	were	now	there!	Android	Studio	sets	up	new	projects	to	deploy	to	the	Android	Emulator	or	a	connected	device.	Once	your	app	is	installed,	you	can	use	Apply	Changes	to	deploy	certain	code	and	resource	changes	without	deploying	a	new	APK	each	time	you	run.	To	build	and	run	your
app,	follow	these	steps:	In	the	toolbar,	select	your	app	from	the	run	configurations	drop-down	menu.	From	the	target	device	drop-down	menu,	select	the	device	that	you	want	to	run	your	app	on.	If	you	don't	have	any	devices	configured,	then	you	need	to	either	connect	a	device	or	create	an	AVD	to	use	the	Android	Emulator.	Click	Run	.	Android	Studio
warns	you	if	you	attempt	to	launch	your	project	to	a	device	that	has	an	error	or	a	warning	associated	with	it.	Iconography	and	stylistic	changes	differentiate	between	errors	(device	selections	that	result	in	a	broken	configuration)	and	warnings	(device	selections	that	may	result	in	unexpected	behavior	but	are	still	runnable).	Note:	You	can	also	deploy
your	app	in	debug	mode	by	clicking	Debug	.	Running	your	app	in	debug	mode	allows	you	to	set	breakpoints	in	your	code,	examine	variables	and	evaluate	expressions	at	runtime,	and	run	debugging	tools.	To	learn	more,	see	Debug	your	app.	Change	the	Run/Debug	configuration	When	you	run	your	app	for	the	first	time,	Android	Studio	uses	a	default
run	configuration.	The	run	configuration	specifies	the	following:	whether	to	deploy	your	app	from	an	APK,	Android	App	Bundle,	or	custom	artifact;	the	module	to	run;	package	to	deploy;	activity	to	start;	target	device;	emulator	settings;	logcat	options;	and	more.	If	the	default	settings	don't	suit	your	project	or	module,	you	can	customize	the	Run/Debug
configuration,	or	even	create	a	new	one,	at	the	project,	default,	and	module	levels.	To	edit	a	Run/Debug	configuration,	select	Run	>	Edit	Configurations.	For	more	information,	see	Create	and	edit	Run/Debug	configurations.	Change	the	build	variant	By	default,	Android	Studio	builds	the	debug	version	of	your	app,	which	is	intended	for	use	only	during
development,	when	you	click	Run.	To	change	the	build	variant	Android	Studio	uses,	select	Build	>	Select	Build	Variant	in	the	menu	bar.	For	projects	without	native/C++	code,	the	Build	Variants	panel	has	two	columns:	Module	and	Active	Build	Variant.	The	Active	Build	Variant	value	for	the	module	determines	which	build	variant	the	IDE	deploys	to
your	connected	device	and	is	visible	in	the	editor.	Figure	1.	The	Build	Variants	panel	has	two	columns	for	projects	that	do	not	have	native/C++	code	To	switch	between	variants,	click	the	Active	Build	Variant	cell	for	a	module	and	choose	the	desired	variant	from	the	list	field.	For	projects	with	native/C++	code,	the	Build	Variants	panel	has	three
columns:	Module,	Active	Build	Variant,	and	Active	ABI.	The	Active	Build	Variant	value	for	the	module	determines	the	build	variant	that	the	IDE	deploys	to	your	device	and	is	visible	in	the	editor.	For	native	modules,	the	Active	ABI	value	determines	the	ABI	that	the	editor	uses,	but	does	not	impact	what	is	deployed.	Figure	2.	The	Build	Variants	panel
adds	the	Active	ABI	column	for	projects	with	native/C++	code	To	change	the	build	variant	or	ABI,	click	the	cell	for	the	Active	Build	Variant	or	Active	ABI	column	and	choose	the	desired	variant	or	ABI	from	the	list.	After	you	change	the	selection,	the	IDE	syncs	your	project	automatically.	Changing	either	column	for	an	app	or	library	module	will	apply
the	change	to	all	dependent	rows.	By	default,	new	projects	are	set	up	with	two	build	variants:	a	debug	and	release	variant.	You	need	to	build	the	release	variant	to	prepare	your	app	for	public	release.	To	build	other	variations	of	your	app,	each	with	different	features	or	device	requirements,	you	can	define	additional	build	variants.	Conflicts	in	Android
Studio’s	Build	Variants	dialog	In	Android	Studio’s	Build	Variants	dialog,	you	might	see	error	messages	indicating	conflicts	between	build	variants,	such	as	the	following:	This	error	does	not	indicate	a	build	issue	with	Gradle	–	it	is	only	indicating	that	the	Android	Studio	IDE	itself	cannot	resolve	symbols	between	the	variants	of	the	selected	modules.	For
example,	if	you	have	a	module	M1	that	depends	on	variant	v1	of	module	M2,	but	M2	has	variant	v2	selected	in	the	IDE,	you	have	unresolved	symbols	in	the	IDE.	Let’s	say	that	M1	depends	on	a	class	Foo	which	is	only	available	in	v1.	When	v2	is	selected,	that	class	is	not	known	by	the	IDE	and	it	will	fail	to	resolve	it	and	show	errors	in	the	code	of	M1.
These	error	messages	appear	because	the	IDE	cannot	load	code	for	multiple	variants	simultaneously.	In	terms	of	your	app’s	build,	however,	the	variant	selected	in	this	dialog	will	have	no	effect	because	Gradle	builds	your	app	with	the	source	code	specified	in	your	Gradle	build	recipes,	not	based	on	what’s	currently	loaded	in	the	IDE.	Build	your
project	The	Run	button	builds	and	deploys	your	app	to	a	device.	However,	to	build	your	app	to	share	or	upload	to	Google	Play,	you'll	need	to	use	one	of	the	options	in	the	Build	menu	to	compile	parts	or	all	of	your	project.	Before	you	select	any	of	the	build	options	listed	in	table	1,	make	sure	you	first	select	the	build	variant	you	want	to	use.	Note:
Android	Studio	requires	AAPT2	to	build	app	bundles,	which	is	enabled	for	new	projects	by	default.	However,	to	make	sure	it	is	enabled	on	existing	projects,	include	android.enableAapt2=true	in	your	gradle.properties	file	and	restart	the	Gradle	daemon	by	running	./gradlew	--stop	from	the	command	line.	Table	1.	Build	options	in	the	Build	menu.	Menu
Item	Description	Make	Module	Compiles	all	source	files	in	the	selected	module	that	have	been	modified	since	the	last	build,	and	all	modules	the	selected	module	depends	on	recursively.	The	compilation	includes	dependent	source	files	and	any	associated	build	tasks.	You	can	select	the	module	to	build	by	selecting	either	the	module	name	or	one	of	its
files	in	the	Project	window.	Make	Project	Makes	all	modules.	Clean	Project	Deletes	all	intermediate/cached	build	files.	Rebuild	Project	Runs	Clean	Project	for	the	selected	build	variant	and	produces	an	APK.	Build	Bundle(s)	/	APK(s)	>	Build	APK(s)	Builds	an	APK	of	all	modules	in	the	current	project	for	their	selected	variant.	When	the	build	completes,
a	confirmation	notification	appears,	providing	a	link	to	the	APK	file	and	a	link	to	analyze	it	in	the	APK	Analyzer.	If	the	build	variant	you've	selected	is	a	debug	build	type,	then	the	APK	is	signed	with	a	debug	key	and	it's	ready	to	install.	If	you've	selected	a	release	variant,	then,	by	default,	the	APK	is	unsigned	and	you	must	manually	sign	the	APK.
Alternatively,	you	can	select	Build	>	Generate	Signed	Bundle	/	APK	from	the	menu	bar.	Android	Studio	saves	the	APKs	you	build	in	project-name/module-name/build/outputs/apk/.	Build	Bundle(s)	/	APK(s)	>	Build	Bundle(s)	Builds	an	Android	App	Bundle	of	all	modules	in	the	current	project	for	their	selected	variant.	When	the	build	completes,	a
confirmation	notification	appears,	providing	a	link	to	the	app	bundle	and	a	link	to	analyze	it	in	the	APK	Analyzer.	If	the	build	variant	you've	selected	is	a	debug	build	type,	then	the	app	bundle	is	signed	with	a	debug	key,	and	you	can	use	bundletool	to	deploy	your	app	from	the	app	bundle	to	a	connected	device.	If	you've	selected	a	release	variant,	then
the	app	bundle	is	unsigned	by	default	and	you	must	manually	sign	it	using	jarsigner.	Alternatively,	you	can	select	Build	>	Generate	Signed	Bundle	/	APK	from	the	menu	bar.	Android	Studio	saves	the	APKs	you	build	in	project-name/module-name/build/outputs/bundle/.	Generate	Signed	Bundle	/	APK	Brings	up	a	dialog	with	a	wizard	to	set	up	a	new
signing	configuration,	and	build	either	a	signed	app	bundle	or	APK.	You	need	to	sign	your	app	with	a	release	key	before	you	can	upload	it	to	the	Play	Console.	For	more	information	about	app	signing,	see	Sign	your	app.	Note:	The	Run	button	builds	an	APK	with	testOnly="true",	which	means	the	APK	can	only	be	installed	via	adb	(which	Android	Studio
uses).	If	you	want	a	debuggable	APK	that	people	can	install	without	adb,	select	your	debug	variant	and	click	Build	Bundle(s)	/	APK(s)	>	Build	APK(s).	For	details	about	the	tasks	that	Gradle	executes	for	each	command,	open	the	Build	window	as	described	in	the	next	section.	For	more	information	about	Gradle	and	the	build	process,	see	Configure	Your
Build.	Monitor	the	build	process	You	can	view	details	about	the	build	process	by	clicking	View	>	Tool	Windows	>	Build	(or	by	clicking	Build	in	the	tool	window	bar).	The	window	displays	the	tasks	that	Gradle	executes	in	order	to	build	your	app,	as	shown	in	figure	3.	Figure	3.	The	Build	output	window	in	Android	Studio	Build	tab:	Displays	the	tasks
Gradle	executes	as	a	tree,	where	each	node	represents	either	a	build	phase	or	a	group	of	task	dependencies.	If	you	receive	build-time	or	compile-time	errors,	inspect	the	tree	and	select	an	element	to	read	the	error	output,	as	shown	in	figure	4.	Figure	4.	Inspect	the	Build	output	window	for	error	messages	Sync	tab:	Displays	tasks	that	Gradle	executes
to	sync	with	your	project	files.	Similar	to	the	Build	tab,	if	you	encounter	a	sync	error,	select	elements	in	the	tree	to	find	more	information	about	the	error.	Restart:	Performs	the	same	action	as	selecting	Build	>	Make	Project	by	generating	intermediate	build	files	for	all	modules	in	your	project.	Toggle	view:	Toggles	between	displaying	task	execution	as
a	graphical	tree	and	displaying	more	detailed	text	output	from	Gradle—this	is	the	same	output	you	see	in	the	Gradle	Console	window	on	Android	Studio	3.0	and	earlier.	If	your	build	variants	use	product	flavors,	Gradle	also	invokes	tasks	to	build	those	product	flavors.	To	view	the	list	of	all	available	build	tasks,	click	View	>	Tool	Windows	>	Gradle	(or
click	Gradle	in	the	tool	window	bar).	If	an	error	occurs	during	the	build	process,	Gradle	may	recommend	some	command-line	options	to	help	you	resolve	the	issue,	such	as	--stacktrace	or	--debug.	To	use	command-line	options	with	your	build	process:	Open	the	Settings	or	Preferences	dialog:	On	Windows	or	Linux,	select	File	>	Settings	from	the	menu
bar.	On	Mac	OSX,	select	Android	Studio	>	Preferences	from	the	menu	bar.	Navigate	to	Build,	Execution,	Deployment	>	Compiler.	In	the	text	field	next	to	Command-line	Options,	enter	your	command-line	options.	Click	OK	to	save	and	exit.	Gradle	applies	these	command-line	options	the	next	time	you	try	building	your	app.	Live	Edit	(experimental)
Important:	This	is	an	experimental	feature	in	active	development,	so	you	might	experience	some	unstable	behavior.	We	are	working	to	improve	this	feature	and	look	forward	to	your	feedback.	If	you	find	an	issue,	please	report	it.	Include	information	from	Logcat	and	a	description	of	the	code	change	you	were	making.	Live	Edit	is	an	experimental
feature	in	the	Android	Studio	Electric	Eel	canary	releases	that	allows	you	to	update	composables	in	emulators	and	physical	devices	in	real	time.	When	you	update	a	composable	function,	your	changes	are	applied	in	your	device	or	emulator	as	you	make	that	change.	This	functionality	minimizes	context	switches	between	writing	and	building	your	app,
allowing	you	to	focus	on	writing	code	longer	without	interruption.	Live	Edit	is	focused	on	UI-	and	UX-related	code	changes.	Live	Edit	doesn't	support	changes	such	as	method	signature	updates,	adding	new	methods,	or	class	hierarchy	changes.	For	more	information,	see	Limitations.	This	feature	is	not	a	replacement	for	building	and	running	your
application	or	Apply	Changes.	Instead,	it's	designed	to	optimize	your	workflow	as	you	build,	deploy,	and	iterate	to	develop	Compose	UI.	The	best	practice	workflow	is	as	follows:	Set	up	your	application	so	that	it	can	be	Run.	Live	Edit	as	much	as	possible,	until	you	need	to	make	a	change	that	Live	Edit	doesn't	support--for	example,	adding	new	methods
while	the	app	is	running.	After	you	make	an	unsupported	change,	Run	your	app	to	resume	Live	Editing.	Figure	5.	Each	time	you	make	an	edit	that	is	supported	by	Live	Edit,	the	running	app	on	your	device	or	emulator	is	updated	in	real	time.	Get	started	with	Live	Edit	To	quickly	get	started,	follow	these	steps	to	create	an	empty	Compose	Activity,
enable	Live	Edit	for	your	project,	and	make	changes	with	Live	Edit.	Set	up	your	new	project	Before	you	begin,	ensure	that	you	have	the	latest	canary	version	of	Android	Studio	Electric	Eel	installed,	and	that	the	API	level	of	your	physical	device	or	emulator	is	at	least	30.	Open	Android	Studio	and	select	New	Project	in	the	Welcome	to	Android	Studio
popup.	If	you	already	have	a	project	open,	you	can	create	a	new	one	by	navigating	to	File	>	New	>	New	Project.	Choose	the	Empty	Compose	Activity	template	for	Phone	and	Tablet,	and	then	click	Next.	Figure	6.	Templates	you	can	choose	from.	For	Live	Edit,	choose	Empty	Compose	Activity.	Enter	the	following,	and	then	click	Finish.	Name:
HelloWorld	Package	name:	com.example.helloworld	Save	location:	Default.	Language:	Kotlin	Minimum	SDK:	Default	Figure	7.	Example	project	settings.	Enable	Live	Edit	In	the	IDE,	navigate	to	the	settings	to	enable	Live	Edit.	On	Windows	or	Linux,	navigate	to	File	>	Settings	>	Editor	>	Live	Edit.	On	macOS,	navigate	to	Android	Studio	>	Preferences
>	Editor	>	Live	Edit.	Figure	8.	Select	the	Live	Edit	option	from	the	settings.	In	the	editor,	open	the	MainActivity	file,	which	is	the	entry	point	for	your	app.	Click	Run	to	deploy	your	app,	and	then	click	Split	on	the	top	right	of	the	editor	to	open	the	preview.	After	you	turn	on	Live	Edit,	you	should	see	the	Live	Edit	green	checkmark	on	the	top	right	of	the
editor.	Figure	9.	The	green	checkmark	and	Live	Edit	dropdown	arrow	appear	after	you	turn	on	Live	Edit.	Make	and	review	changes	In	the	editor,	change	the	existing	Greeting	method	in	MainActivity	to	the	following.	Your	changes	appear	instantaneously,	as	shown	in	figure	10.	@Composable	fun	Greeting(name:	String)	{	Text(text	=	"Hello	$name!",
Modifier.padding(80.dp)	//	Outer	padding;	outside	background	.background(color	=	Color.Cyan)	//	Solid	element	background	color	.padding(16.dp)	//	Inner	padding;	inside	background,	around	text)	)	}	Figure	10.	Live	Edit	changes	to	the	Greeting	method	above	appear	instantly.	Troubleshooting	If	you	don't	see	your	edits	in	the	preview	pane,	Android
Studio	might	have	failed	to	update	your	edits.	Check	if	the	Live	Edit	UI	indicator	shows	a	paused	icon,	which	indicates	a	compilation	error.	Figure	11.	To	see	more	information	about	the	error	and	suggestions	for	how	to	resolve	it,	hover	over	Live	Edit:	ON	in	the	UI.	Limitations	Note:	Live	Edit	is	an	experimental	feature	in	Electric	Eel	canary	builds,
which	means	there	are	some	known	issues	and	limitations.	We	look	forward	to	your	feedback	while	we	work	on	improving	the	feature.	You	can	also	see	a	list	of	open	issues	here.	The	following	is	a	list	of	current	limitations.	Live	Edit	requires	a	physical	device	or	emulator	that	is	running	API	level	30	or	higher.	Live	Edit	only	supports	editing	a	function
body,	which	means	that	you	can't	change	the	function	name	or	the	signature,	add	or	remove	a	function,	or	change	non-function	fields.	Live	Edit-modified	classes	may	incur	some	performance	penalty.	We	recommend	that	you	Run	your	app	and	use	a	clean	Release	build	if	you	are	evaluating	its	performance.	You	must	perform	a	full	Run	in	order	for	the
debugger	to	operate	on	classes	that	you	have	modified	with	Live	Edit.	A	running	app	might	crash	when	you	edit	it	with	Live	Edit.	If	this	happens,	you	can	redeploy	the	app	with	the	Run	button.	Live	Edit	doesn't	perform	any	bytecode	manipulation	that's	defined	in	your	project's	build	file–for	example,	bytecode	manipulation	that	would	be	applied	when
the	project	is	built	using	the	options	in	the	Build	menu	or	by	clicking	the	Build	or	Run	buttons.	Non-Composable	functions	are	updated	live	on	the	device	or	emulator	and	a	full	recomposition	is	triggered.	The	full	recomposition	might	not	invoke	the	updated	function.	For	non-composable	functions,	you	must	trigger	the	newly	updated	functions,	or	Run
the	app	again.	Live	Edit	doesn't	resume	on	app	restarts.	You	must	Run	the	app	again.	Frequently	asked	questions	What	is	the	current	status	of	Live	Edit?	Live	Edit	is	available	in	the	Android	Studio	Electric	Eel	canary	channel	as	an	experimental	feature.	You	can	turn	it	on	or	off	by	navigating	to	File	>	Settings	>	Editor	>	Live	Edit	(Android	Studio	>
Preferences	>	Editor	>	Live	Edit	on	macOS).	When	should	I	use	Live	Edit?	Use	Live	Edit	when	you	want	to	quickly	see	the	effect	of	updates	to	UX	elements	(e.g.	modifier	updates,	animations)	on	the	overall	app	experience.	When	should	I	avoid	using	Live	Edit?	Live	Edit	is	currently	focused	on	UI-	and	UX-related	code	changes.	Avoid	using	it	for
changes	such	as	method	signature	updates,	adding	new	methods,	or	class	hierarchy	changes,	which	it	does	not	support.	For	more	information,	see	Limitations.	When	should	I	use	Compose	Preview?	Use	Composition	Preview	when	you're	developing	individual	composables.	Preview	visualizes	Compose	elements	and	automatically	refreshes	to	display
the	effect	of	code	changes.	Preview	also	supports	viewing	UI	elements	under	different	configurations	and	states	(e.g.	dark	mode,	locales,	font	scale).	Apply	Changes	In	Android	Studio	3.5	and	higher,	Apply	Changes	lets	you	push	code	and	resource	changes	to	your	running	app	without	restarting	your	app—and,	in	some	cases,	without	restarting	the
current	activity.	This	flexibility	helps	you	control	how	much	of	your	app	is	restarted	when	you	want	to	deploy	and	test	small,	incremental	changes	while	preserving	your	device's	current	state.	Apply	Changes	uses	capabilities	in	the	Android	JVMTI	implementation	that	are	supported	on	devices	running	Android	8.0	(API	level	26)	or	higher.	To	learn	more
about	how	Apply	Changes	works,	see	Android	Studio	Project	Marble:	Apply	Changes.	Requirements	Apply	Changes	actions	are	only	available	when	you	meet	the	following	conditions:	You	build	the	APK	of	your	app	using	a	debug	build	variant.	You	deploy	your	app	to	a	target	device	or	emulator	that	runs	Android	8.0	(API	level	26)	or	higher.	Use	Apply
Changes	Use	the	following	options	when	you	want	to	deploy	your	changes	to	a	compatible	device:	Apply	Changes	and	Restart	Activity	Attempts	to	apply	both	your	resource	and	code	changes	by	restarting	your	activity	but	without	restarting	your	app.	Generally,	you	can	use	this	option	when	you've	modified	code	in	the	body	of	a	method	or	modified	an
existing	resource.	You	can	also	perform	this	action	by	pressing	Ctrl+Alt+F10	(or	Control+Shift+Command+R	on	macOS).	Apply	Code	Changes	Attempts	to	apply	only	your	code	changes	without	restarting	anything.	Generally,	you	can	use	this	option	when	you've	modified	code	in	the	body	of	a	method	but	you	have	not	modified	any	resources.	If	you've



modified	both	code	and	resources,	use	Apply	Changes	and	Restart	Activity	instead.	You	can	also	perform	this	action	by	pressing	Ctrl+F10	(or	Control+Command+R	on	macOS).	Run	Deploys	all	changes	and	restarts	the	app.	Use	this	option	when	the	changes	that	you	have	made	cannot	be	applied	using	either	of	the	Apply	Changes	options.	To	learn
more	about	the	types	of	changes	that	require	an	app	restart,	see	Limitations	of	Apply	Changes.	Enable	Run	fallback	for	Apply	Changes	After	you've	clicked	either	Apply	Changes	and	Restart	Activity	or	Apply	Code	Changes,	Android	Studio	builds	a	new	APK	and	determines	whether	the	changes	can	be	applied.	If	the	changes	can't	be	applied	and	would
cause	Apply	Changes	to	fail,	Android	Studio	prompts	you	to	Run	your	app	again	instead.	However,	if	you	don't	want	to	be	prompted	every	time	this	occurs,	you	can	configure	Android	Studio	to	automatically	rerun	your	app	when	changes	can't	be	applied.	To	enable	this	behavior,	follow	these	steps:	Open	the	Settings	or	Preferences	dialog:	On	Windows
or	Linux,	select	File	>	Settings	from	the	menu	bar.	On	macOS,	select	Android	Studio	>	Preferences	from	the	menu	bar.	Navigate	to	Build,	Execution,	Deployment	>	Deployment.	Select	the	checkboxes	to	enable	automatic	Run	fallback	for	either	of	the	Apply	Changes	actions.	Click	OK.	Note:	Some	types	of	changes	don't	cause	Apply	Changes	to	fail,	but
still	require	you	to	restart	your	app	manually	before	you	can	see	those	changes.	For	example,	if	you	make	changes	to	an	activity's	onCreate()	method,	those	changes	only	take	effect	after	the	activity	is	relaunched,	so	you	must	restart	your	app	to	see	those	changes.	Platform-dependent	changes	Some	features	of	Apply	Changes	depend	on	specific
versions	of	the	Android	platform.	To	apply	these	kinds	of	changes,	your	app	must	be	deployed	to	a	device	running	that	version	of	Android	(or	higher).	Type	of	change	Minimum	platform	version	Adding	a	method	Android	11	Limitations	of	Apply	Changes	Apply	Changes	is	designed	to	speed	up	the	app	deployment	process.	However,	there	are	some
limitations	for	when	it	can	be	used.	If	you	encounter	any	issues	while	using	Apply	Changes,	file	a	bug.	Code	changes	that	require	app	restart	Some	code	and	resource	changes	cannot	be	applied	until	the	app	is	restarted,	including	the	following:	Adding	or	removing	a	field	Removing	a	method	Changing	method	signatures	Changing	modifiers	of
methods	or	classes	Changing	class	inheritance	Changing	values	in	enums	Adding	or	removing	a	resource	Changing	the	app	manifest	Changing	native	libraries	(SO	files)	Libraries	and	plugins	Some	libraries	and	plugins	automatically	make	changes	to	your	app's	manifest	files	or	to	resources	that	are	referenced	in	the	manifest.	These	automatic	updates
can	interfere	with	Apply	Changes	in	the	following	ways:	If	a	library	or	plugin	makes	changes	to	your	app's	manifest,	you	can't	use	either	Apply	Code	Changes	or	Apply	Changes	and	Restart	Activity	and	have	to	restart	your	app	before	you	can	see	your	changes.	If	a	library	or	plugin	makes	changes	to	your	app's	resource	files,	you	can't	use	Apply	Code
Changes	,	and	you	must	use	Apply	Changes	and	Restart	Activity	to	see	your	changes.	You	can	avoid	these	limitations	by	disabling	all	automatic	updates	for	your	debug	build	variants.	For	example,	Crashlytics	updates	app	resources	with	a	unique	build	ID	during	every	build,	which	prevents	you	from	using	Apply	Code	Changes	and	requires	you	to
restart	your	app's	activity	to	see	your	changes.	You	can	disable	this	behavior	so	that	you	can	use	Apply	Code	Changes	alongside	Crashlytics	with	your	debug	builds.	Code	that	directly	references	content	in	an	installed	APK	If	your	code	directly	references	content	from	your	app's	APK	that's	installed	on	the	device,	that	code	can	cause	crashes	or
misbehave	after	clicking	Apply	Code	Changes	.	This	behavior	occurs	because	when	you	click	Apply	Code	Changes,	the	underlying	APK	on	the	device	is	replaced	during	installation.	In	these	cases,	you	can	click	Apply	Changes	and	Restart	Activity	or	Run	,	instead.
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